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Online Training Program Offered by CADCIM Technologies

CADCIM Technologies provides effective and affordable virtual online training on various software
packages including Computer Aided Design and Manufacturing (CAD/CAM), computer programming
languages, animation, architecture, and GIS. The training is delivered live’ via Internet at any time,
any place, and at any pace to individuals as well as the students of colleges, universities, and CAD/CAM
tramning centers. The main features of this program are:

Training for Students and Companies in a Classroom Setting

Highly experienced instructors and qualified engineers at CADCIM “Technologies conduct the classes under
the guidance of Prof. Sham Tickoo of Purdue University Calumet, USA. This team has authored several
textbooks that are rated “one of the best” in their categories and are used in various colleges, universities,
and traiming centers i North America, Europe, and in other parts of the world.

Training for Individuals

CADCIM Technologies with its cost effective and time saving iitiative strives to deliver the training in
the comfort of your home or work place, thereby relieving you from the hassles of traveling to training
centers.

Training Offered on Software Packages

CADCIM provides basic and advanced training on the following software packages:

CAD/CAM/CAE: CATIA, Pro/ENGINEER Wildfire, Creo Parametric, Creo Direct, SolidWorks, Autodesk
Inventor, Solid Edge, NX, AutoCAD, AutoCAD LT, AutoCAD Plant 3D, Customizing AutoCAD,
EdgeCAM, and ANSYS

Architecture and GIS: Autodesk Revit Architecture, AutoCAD Civil 3D, Autodesk Revit Structure,
AutoCAD Map 3D, Revit MEE Navisworks, Primavera Project Planner, and Bentley STAAD Pro

Animation and Styling: Autodesk 3ds Max, Autodesk 3ds Max Design, Autodesk Maya,
Autodesk Alias, Foundry NukeX, and MAXON CINEMA 4D

Computer Programming: C++, VB.NET, Oracle, AJAX, and Java

For more information, please visit the following link: http://www.cadcim.com

Note

If you are a faculty member, you can register by clicking on the following link to access
the teaching resources: http://www.cadcim.com/Registration.aspx. The student resources
are available at http://www.cadcim.com. We also provide Live Virtual Online Training
on various software packages. For more information, write us at sales@cadcim.com.
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Preface

PTC Creo Parametric 3.0

PTC Creo Parametric, developed by Parametric Technology Corporation, is a new technology
in the series of Pro/ENGINEER. It provides a broad range of powerful and flexible CAD
capabilities that can address even the most tedious design challenges. Being a parametric
feature-based solid modeling tool, it not only integrates the 3D parametric features with
2D tools, but also assists in every design-through-manufacturing process. This software is
remarkably user-friendly and it contributes to the enhanced of the entire design process.

This solid modeling software allows you to easily import the standard format files with an
amazing compatibility. The 2D drawing views of the components are automatically generated
in the Drawing mode. Using this software, you can generate detailed, orthographic, isometric,
auxiliary, and section views. Additionally, you can use any predefined drawing standard files
for generating the drawing views. You can display the model dimensions in the drawing views
or add reference dimensions whenever you want. The bidirectionally associative nature of this
software ensures that any modification made in the model is automatically reflected in the
drawing views. Similarly, any modification made in the dimensions of the drawing views is
automatically updated in the model.

The PTC Creo Parametric 3.0 for Engineers and Designers textbook has been written to
enable the readers to use the modeling power of PTC Creo Parametric 3.0 effectively. The latest
surfacing techniques like Freestyle and Style are explained in detail in this book. The textbook
also covers the Sheetmetal module with the help of relevant examples and illustrations. The
mechanical engineering industry examples and tutorials are used in this textbook to ensure that
the users can relate the knowledge of this book with the actual mechanical industry designs.
The salient features of this textbook are as follows:

* Tutorial Approach
The author has adopted the tutorial point-of-view and the learn-by-doing approach
throughout the textbook. This approach guides the users through the process of
creating the models in the tutorials.
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* Real-World Projects as Tutorials
The author has used the real-world mechanical engineering projects as tutorials in
this textbook so that the readers can correlate them with the real-time models in the
mechanical engineering industry.

* Tips and Notes
Additional information related to various topics is provided in the form of tips and
notes.

* Learning Objectives
The first page of every chapter summarizes the topics that will be covered in that
chapter. This helps the users to easily refer to a topic.

* Self-Evaluation Test, Review Questions, and Exercises
Every chapter ends with a Self-Evaluation test so that the users can assess their
knowledge of the chapter. The answers to the Self-Evaluation test are given at the end
of the chapter. Also, the Review Questions and Exercises are given at the end of each
chapter and they can be used by the Instructors as test questions and exercises.

* Heavily Illustrated Text

The text in this book is heavily illustrated with the help of around 1400 line diagrams
and screen capture images that support the tools section and tutorials.

Symbols Used in the Text

Note
@ The author has provided additional information to the users about the topic
being discussed in the form of notes.

; Tip
Q Special information and techniques are provided in the form of tips that helps
: in increasing the efficiency of the users.

- New
We'lp This symbol indicates that the command or tool being discussed is new.
P Enhanced
%nﬁ% This symbol indicates that the command or tool being discussed has been
L&Y

enhanced in PTC Creo Parametric 3.0.
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Formatting Conventions Used in the Text

Please refer to the following list for the formatting conventions used in this textbook.

*  Names of tools, buttons, options, groups, Example: The Extrude tool, the OK button,
tabs, slide-down panels, and Ribbon are the Editing group, the Sketch tab, and so
written in boldface. on.

* Names of dialog boxes, drop-downs, Example: The Revolve dashboard, the
drop-down lists, dashboards, areas, edit Chamfer drop-down of Engineering group in
boxes, check boxes, and radio buttons are  the Model tab, the Thickness drop-down of
written in boldface. the Shell dashboard, the Extended intersect

surfaces check box in the Options slide-down
panel of the Draft dashboard, and so on.

*  Values entered in edit boxes are written Example: Enter 5 in the Radius edit box.
in boldface.

*  Names and paths of the files are written ~Example: C:\Creo-3.0\c03, ¢03tut03.prt, and
in italics. so on.

* Different options available for invoking B Ty e—————
a tool are given in a shaded command

box.

Naming Conventions Used in the Text

Tool
If you click on an item in a toolbar or a group of the Ribbon and a dashboard or dialog box
is invoked to create/edit an object or perform some action, then that item is termed as tool.

For example:

Line tool, Normal tool, Extrude tool

Fillet tool, Draft tool, Delete Segment tool

If you click on an item in a toolbar or a group of the Ribbon and a dialog box is invoked
wherein you can set the properties to create/edit an object, then that item is also termed as
tool, refer to Figure 1.

For example:
To Create: Extrude tool, Sweep tool, Round tool
To Edit: Extend tool, Trim tool

Engineering ¥ Editing + Surfaces * Hodel Intent

Figure 1 Various tools in the Ribbon



xviii PTC Creo Parametric for Engineers and Designers

Button
The item in a dialog box that has a 3D shape like a button is termed as Button. For example,
OK button, Cancel button, Apply button, and so on.

Dialog Box

The naming conventions for the components in a dialog box are shown in Figure 2.

PTC Creo Parametric Options x
Favorites ™| change how the model is displaysd
Enviranment
System Colors Model orientation -
Wodel Display Defautt model orientation: | Trimetric ~
Entity Disph
sr;qzymiu‘:p ¥ Model display settings when reorienting the model
Skelcher [V Show the orientation center
Assembly [] Show datums
Notificati
Eagi:;ex";g” [] Fast hidden lnes removal
Board W Show surface mesh
Data Exchange [] show sinouetts edges
Shestmetal
Update Control [] Use time to draw frames
Customize Risbon ™ Show animation
Quick Access Toolbar
Window Seftings Set maximum number of seconds spent animating to 10 Edit box
Shortcut Henu Set minimum number of frames displayed for animation to: g &

- Shaded mode| display settings.
Licensing

Configuration Editor Set shade qualty to 35 Spinner
Check box ¥ Show surface features

W Show datum curve features

[] sShade very smal surfaces.
[ shade manufacturing reference model

[T] Use level of detais for the shaded model when manipulation the view

[V Show textures on shaded model
[ Enable transparency

Transparency: | Blended - Drop-down
W Show clipped model as solid

Area —————————————————feaktime rendering settings
[V Enable environment reflection on mode!

Apply

Export Configurations... oK Cancel ——— Button

Figure 2 The components in a dialog box

Drop-down

A drop-down is one in which a set of common tools are grouped together for creating an
object. You can identify a drop-down with a down arrow on it. These drop-downs are given a
name based on the tools grouped in them. For example, Arc drop-down (refer to Figure 3),
Chamfer drop-down (refer to Figure 4), Draft drop-down (refer to Figure 5), and so on.

3 arclw| A Fillet ~

*3J  3-Point/ Tangent End

i ] .
™, Center and Ends 7~ Chamfer = 1 Thic
=y 3 Tangent

- Chamfer

33y Concentric /_

5 conic ¢~ Chamfer Trim

Figure 3 The Arc drop-down Figure 4 The Chamfer drop-down
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_bs Draft =

=1

Iy Draft

j- “ariable Pull Direction Draft

Figure 5 The Draft drop-down

Drop-down List

A drop-down list is the one in which a set of options are grouped together. You can set various
parameters using these options. You can identify a drop-down list with a down arrow on it.
For example, Dimension drop-down list, Clear Appearance drop-down list, and so on, refer
to Figure 6.

Dimension |=

Dimension

Direction

Axiz

Fill

Table o lerﬂrA|:>[:\f:ﬂrﬂnct:T
Reference (# Clear Appearance
Curve Clear Assembl
Paoint % Clear AllAppearances

Figure 6 The Dimension and Clear Appearance drop-down lists

Options

Options are the items that are available in shortcut menu, drop-down list, dialog boxes, and
so on. For example, choose the Front option from the View Manager dialog box, refer to
Figure 7; choose the New option from the File menu, refer to Figure 8.

File ~ Model  Analysis  Annotate = MewTab Render Tools
I_l}-‘ o Recent Files
L‘ [ Mew (Ctri+N) -3.07Tuts\cOP\CO7Hut! prt =
Create a new model. §-3.0RESOURCES\.. igure6-62.prt =
h -3.07Tuts\cOB\C0BULD1 prt =
Simp Rep Sections Layerz | Orient | All 1 4 C\Creo-3.0\Tuts\cOB\COBIULO2 prt =
hH saveAs b
T § C\Creo-3.00Tuls\.. \shock_assembly.asm =
Hew Edit ~ | © Options ~ Ll print ) BE\Creo-3.0\ \igureS-39-41 prt =
_ 7 EA\Creo-3 0\RESOURCESY. -39 prt =
e
Mames Close 8 E‘\Creo-3 0\RESOURCESY. \figured-33 prt =
T Ot 9 ECreo-3.0\RESOURCESN.. Yfigure4-16.prt =
¥ Standard Orisiat. fanage pie »  CICTEo-0RESOURCESL. Mgured-7.ort =
Default Orientation Ci\Creo-3.0Tuts\c09\cOStut! prt i=
Back Prepare b CiMCreo-2.0VTuts\c09\cOStut2 prt i=
C:\Creo-3.0VTuts\c1 O\ 1Ottt prt i=
Bottom Send 3
Front
Manage Session *
Left
4 Hel F
Right "
Top i=| options
(] o
Close
Debug ~

Figure 7 The Front option in
the View Manager dialog box

Figure 8 The New option in the File menu
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Free Companion Website

It has been our constant endeavor to provide you the best textbooks and services at affordable
price. In this endeavor, we have come out with a Free Companion website that will facilitate the
process of teaching and learning of PTC Creo Parametric 3.0. If you purchase this textbook from
our website (www.cadcim.com), you will get access to the files on the Companion website.

The following resources are available for the faculty and students in this website:

Faculty Resources
* Technical Support
You can get online technical support by contacting techsupport@cadcim.com.

¢ Instructor Guide
Solutions to all review questions and exercises in the textbook are provided in this link to
help the faculty members test the skills of the students.

* PowerPoint Presentations
The contents of the book are arranged in PowerPoint slides that can be used by the faculty
for their lectures.

¢ Part Files
The part files used in illustration, tutorials, and exercises are available for free download.

Student Resources
* Technical Support
You can get online technical support by contacting techsupport@cadcim.com.

* Part Files
The part files used in illustrations and tutorials are available for free download.

* Additional Students Projects
Various projects are provided for the students to practice.

Ifyou face any problem in accessing these files, please contact the publisher at sales@cadcim.com
or the author at stickoo @purduecal.edu or tickoo525@gmail.com.

Stay Connected

You can now stay connected with us through Facebook and Twitter to get the latest information
about our textbooks, videos, and teaching/learning resources. To stay informed of such updates,
follow us on Facebook (www.facebook.com/cadcim) and Twitter (@cadcimtech). You can also
subscribe to our YouTube channel (www.youtube.com/cadcimtech) to get the information about
our latest video tutorials.



